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Introduction

This guide provides instructions for installing and removing the OCTANE™ Digital
Video and OCTANE Compression boards in an OCTANE workstation. Below is an
overview of the contents of this guide.

• The introduction provides additional hardware resource information, and product
support information.

• Chapter 1 provides an overview of the features of the OCTANE Digital Video board
as well as installation instructions. It also explains how to set up single-link and
dual-link connections, and describes the options on the Video Control Panel.

• Chapter 2 provides instructions for removing the Digital Video option board.

• Chapter 3 provides instructions for installing the OCTANE Compression board in
the OCTANE workstation, and linking it to the OCTANE Digital Video board.

• Chapter 4 provides instructions for removing the OCTANE Compression board.

• Appendix A provides Digital Video board information on framelocking.

• Appendix B provides illustrations of the OCTANE Digital Video and OCTANE
Compression boards, and the OCTANE/SI, OCTANE/SI with texture memory
option board, OCTANE/SSI, and OCTANE/MXI graphics boards.

• Appendix C provides instructions on the care and cleaning of the XIO™
compression connector.

It’s always a good idea to back up your system before installing a new board. If you have
not backed up your system recently, do so now. For instructions on backing up your
system, see the online Personal System Administration Guide.

Additional Hardware Information

You can find additional hardware information online at OCTANE Hardware Central. This
online resource provides access to hardware movies and other information previously
found only in your printed owner’s guide, such as port pinout information, user tips,
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environmental information, and so on. To bring up OCTANE Hardware Central, open
Netscape. In the location window, type
file:/usr/share/Insight/library/SGI_bookshelves/SGI_EndUser/books

/Octane_HWCntl/index.html

You can also access OCTANE Hardware Central by choosing Toolchest > Selected > File
QuickFind. When a window appears, type inSight. When the IRIS InSight™ Bookshelf
appears, choose SGI EndUser > OCTANE Hardware Central. If this document is no longer
installed on your system disk, see your OCTANE Workstation Owner’s Guide for
instructions on reinstalling this guide.

Software and System Administration Information

For complete information on installing software, see the online Personal System
Administration Guide. Find it from your desktop by choosing Toolchest > Help > Online
Books. For more advanced information, see the online IRIX Admin: Software Installation &
Licensing Guide. For system administration information, see the SGI Admin section of the
online bookshelf.

Product Support

The OCTANE workstation is designed so that you can maintain and repair it without the
help of a trained technician. Contact your Silicon Graphics subsidiary or authorized
distributor for information about product support.

Silicon Graphics, Inc., provides a comprehensive range of product support for its
products. If you are in North America and would like support for your Silicon Graphics
supported products, contact the Technical Assistance Center at 1-800-800-4SGI or your
authorized service provider. If you are outside North America, contact the Silicon
Graphics subsidiary or authorized distributor in your country.
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Chapter 1

1. Installing the OCTANE Digital Video Board

About the OCTANE Digital Video Board

The 10-bit all-digital OCTANE Digital Video option board provides multiple channels of
input and output, industry-standard formats, and real-time video processing.

You can send and receive live component digital video from any serial
CCIR-601/SMPTE-259M-compliant device. The OCTANE Digital Video board is
compatible with NTSC (525-line) and PAL (625-line) television standards and supports
the following formats:

• Two channels YUV 4:2:2 (8- or 10-bit)

• One channel YUVA 4:2:2:4 (8- or 10-bit)

• One channel YUVA 4:4:4:4 (8- or 10-bit)

• Two channels 8-bit arbitrary data

Other connections provide genlock input, genlock loopthrough, and GPI trigger signals.

The OCTANE Digital Video board provides real time color space conversion/video
texture mapping and the ability to

• translate between YUVA and RGBA in real time

• create alpha channels from superblack YUV

• use a video signal as a texture map on any 3D object (texture mapping)
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Unpacking the OCTANE Digital Video Board

Figure 1-1 Checking the Shipment

It’s a good idea to check your shipment when you receive it. You should receive the
supplies shown in Figure 1-1.

Installing System and Video Software

Before shutting down your system and installing the Digital Video board, install the
appropriate version of the IRIX™ operating system and the OCTANE Digital Media
software.

6 screws

Wrist strap

Octane Digital video board

Digital Media CD

Reversible
screwdriver

Documentation

XIO compression connector cap

Cable guard
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See the release notes labeled OCTANEvideo.man.relnotes on the CD. Also see the CD
booklet enclosed with the CD for information on remotely logging in to another machine
with a CD-ROM drive.

To review release notes, choose Toolchest > Help > Release Notes. Release notes are
available here after the software has been installed.

To display ASCII test in an IRIX shell, at the prompt, enter cdrelnotes.

Preparing the Workstation

This section contains instructions on installing the OCTANE Digital Video board. A brief
summary of the process follows:

To install the OCTANE Digital Video board, power off the workstation and monitor,
unplug the power cord, attach the wrist strap, wait 5 minutes, remove the XIO module,
install the Digital Video board, replace the module, remove the wrist strap, plug in the
power cord, and power on the OCTANE workstation and the monitor. Complete
instructions begin on the following page.

Tools and Parts Needed

• A wrist strap

• Documentation

• A reversible screwdriver

• Extra long screws for attaching the Digital Video board.

• An XIO compression connector cap to protect the graphics board XIO compression
connector when it is out of the workstation. (A cap comes on the OCTANE Digital
Video boards’ XIO compression connector. Extra caps come with the workstation.)

• A blank panel if you are removing the Digital Video or Compression board and are
not replacing it. (A blank panel came with the workstation and was in the slot filled
by the OCTANE Digital Video board.)
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Figure 1-2 Powering Off the OCTANE Workstation

1. Open the cover and push the power button to power off the OCTANE workstation.

2. Unplug the power cord.

3. Push the power switch on the monitor to power it off.

4. Face the rear of the workstation.

Warning: The heat sinks on the XIO boards become very hot. Wait 5 minutes
after powering off the OCTANE workstation before you remove the XIO module.
Test before touching any of the XIO boards.

Power button1

Power cord

2

Power button3
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Figure 1-3 Removing the Monitor Cable

5. Remove the monitor cable or other cables from the XIO module. (For illustration
purposes, only the monitor cable is shown in Figure 1-3.)

The XIO module can be thought of as a tray to which the XIO graphics boards and option
boards are attached.

Note: The XIO module is always installed with the graphics board toward the top of the
workstation, in the upper left quadrant. See Figure 1-3.

To monitor

XIO module

Graphics board
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Attaching the Wrist Strap

Figure 1-4 Attaching the Wrist Strap

Caution: The components inside the OCTANE workstation are extremely sensitive to
static electricity; you must wear the wrist strap while replacing parts inside the
workstation.

To attach the wrist strap, follow these steps:

1. Unwrap the first two folds of the band and wrap the exposed adhesive side firmly
around your wrist.

2. Unroll the rest of the band and peel the liner from the copper foil at the opposite
end.

3. Attach the copper foil to a convenient and exposed electrical ground, such as a
metal part of the OCTANE workstation.

Unroll1

2
3
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Removing the XIO Module

Before removing the XIO module, you must power off the OCTANE workstation, wait
5 minutes after powering off the workstation to allow the heat sinks to cool, and attach
the wriststrap. If you have not already done this, go to “Preparing the Workstation” on
page 3 and follow the instructions through attaching the wriststrap. Then return here
and follow the directions.

Figure 1-5 Identifying the Compression Connector

When you remove the XIO module, the compression connectors on the back of the XIO
module (XIO boards) are accessible and easily damaged. All XIO graphics boards have
compression connectors, and most XIO option boards do.

Caution: The compression connectors on each XIO board are very delicate and easily
damaged. Do not touch or bump the gold, bristled pad. Before you remove the XIO
module, read Appendix C, “Care and Cleaning of the Compression Connector.”

Bristled pad
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Figure 1-6 Removing the XIO Module Screws

Warning: The heat sinks on the XIO boards become very hot. Wait 5 minutes after
powering off the OCTANE workstation before you remove the XIO module. Test
before touching any of the XIO boards.

The XIO module is the holding mechanism for XIO graphics or XIO option boards and
holds up to four boards. It can be thought of as a tray to which boards are attached.

1. Loosen the two captive screws in the XIO module handles until the handles move
free from the workstation.
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Figure 1-7 Removing the XIO Module

2. Grasp the handles and pull until the XIO module protrudes a few inches from the
chassis.

The handles and the XIO module move out about two inches before the I/O panels
move.

3. Continue to pull on the handles until the XIO module releases from the workstation.
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Figure 1-8 Supporting the XIO Module

4. Grasp the XIO module along its length, and support the module and XIO boards
with your hands as you remove them from the chassis.

XIO module
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Figure 1-9 Placing the XIO Module on Its Side

The handles protrude from beneath the XIO boards when the XIO module is out of
the chassis. When protruding, the identification slots for the XIO boards, D and A, B
and C, are visible. Slots B and C are on the opposite side of the XIO module from
slots D and A.

Note: Do not push on the handle area after you have removed the XIO module. The
XIO module locks to the workstation only if the handle area is protruding.

5. Place the XIO module on a flat, antistatic surface. An empty antistatic bag on your
desk works well.

SI graphics board

Blank panel

I/O panel
XIO module

Slot A

Slot D

UP
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Figure 1-10 Placing a Protective Cap on the XIO Compression Connector

6. Place a cap on the XIO graphics board compression connector.

Note: The cap prevents damage to the gold (front) surface when the XIO boards are
removed from OCTANE. These caps are placed on any XIO compression connector
as soon as the XIO module is removed from the chassis, and then removed before
placing the XIO module back in the chassis.

See Appendix C “Care and Cleaning of the XIO Compression Connector,” for more
information.

Caution: Do not touch
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About the XIO Module

The XIO module is the holding mechanism for XIO graphics or XIO option boards and
holds up to four boards. It can be thought of as a tray to which boards are attached. The
four quadrants of the XIO module are Slots A, B, C, and D. Slots D and A are on one side,
Slots B and C on the other. A graphics board, option board, or blank panel attaches to
each slot on the XIO module.

• The XIO module must be placed so that the graphics board in slot A is in the upper
left corner, or they may overheat and be damaged.

• The graphics board is always in slot A or slots A and D.

• Option boards occupy slots B and C and possibly D.

• Graphics and option boards may be linked by flex cables.

• Protective blank panels must be placed in unused slots.

• A baffle must be attached to two side-by-side blank panels to ensure proper air flow.

• The XIO compression connector is always covered by a protective cap when an XIO
board is out of the OCTANE workstation.

• Extra caps for the compression connectors are shipped with the workstation.

Attaching the OCTANE Digital Video Board to the XIO Module

Attaching the Digital Video board is a lengthy process. Here is a quick overview of the
preliminary steps.

Before installing the OCTANE Digital Video board, you must power off the OCTANE
workstation, wait 5 minutes for the heat sinks to cool, attach a wriststrap, and remove the
XIO module. If you have not already done so, see “Preparing the Workstation” on page 3
and follow the instructions through removing the XIO module. If you have already
removed the XIO module, go to step 1 on the next page. (Be sure to also read “About the
XIO Module and XIO Boards” before beginning your task.)

Caution: Do not touch the gold (front) surface of the XIO compression connector.
Touching it could damage the connector. Place a protective cap on the XIO compression
connector, to prevent damage when the XIO boards are removed from the OCTANE
workstation. See Appendix C, “Care and Cleaning of the Compression Connector.”
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Removing the Blank Panel or Option Board

Figure 1-11 Removing the Baffle

1. Turn the XIO module so that slots B and C are facing you. Select your next step from
Table 1-1.

Table 1-1 Choosing the Next Instruction

If You Have Go to

An option board in slot B The option board installation guide for
instructions on removing the board

A blank panel in slot B and an option board
in slot C

Step 3

Blank panels in slots B and C Step 2

Slot C
B

C

Baffle

Blank panel

B

C

Slot B
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Figure 1-12 Removing the Baffle

2. Remove the baffle attached to the two blank panels.

■ Using a Phillips screwdriver, remove the four screws holding the baffle to the
two blank panels.

■ Remove the baffle.

■ Replace the two screws into the blank panel in slot C.

3. Remove the remaining screws from the blank panel in slot B.

4. Remove the blank panel. Keep it in case you remove an option board. A blank panel
or board must be in place in each slot on the XIO module.

Slot B

Slot C

Baffle

Blank Panel

B

C
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Figure 1-13 Attaching the Digital Video Board With Daughterboard to the XIO Module

5. Place the Digital Video board on the XIO module, aligning the holes in the board to
the standoffs on the XIO module.

6. Insert and tighten the four screws (which came with the Digital Video board)
through the Digital Video board into the standoffs on the XIO module.

Graphics board

Slot C

Slot B

Digital Video Screws

B

C

Digital Video board
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Attaching the Flex Cables

Figure 1-14 Attaching the Flex Cables From the Digital Video Board to the Graphics Board

1. Turn over the XIO module so that you are facing the graphics board in slot A or A
and D.

2. Attach the flex cables from the Digital Video board in slot B to the graphics board in
slot A.

■ Attach the connector with the shortest flex cable (from the Digital Video board)
to connector A on the graphics board. Press down on the middle of the
connector to ensure proper seating.

■ Lay the middle flex cable through the release levers of connector A, then attach
the connector. Press down on the middle of the connector to seat it.

Graphics board

ABC

A
B

C

Release levers

UP
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Figure 1-15 Attaching the Flex Cables to the Graphics Board

■ Lay the longest flex cable through the release levers of connectors A and B.
Attach the connector and press down on the middle of the connector to seat it.

Graphics board

ABC

A
B

C

Release levers

UP
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Installing the Cable Guard

This section describes how to install the cable guard on the Digital Video board.

Figure 1-16 Attaching the Flex Cable Protector

The flex cable guard protects the flex cables from being scratched or caught on the chassis
when the XIO module is inserted or removed from the workstation.

The flex cable guard slides under the I/O panels and attaches beneath the screw on the
graphics board, and behind the standoff between the Digital Video board and its
daughterboard.

Graphics board

A
B

C

Flex cables 

Digital Video board

Standoff 

I/O panels

Daughterboard
UP
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Figure 1-17 Removing the Screw From the Graphics Board

1. Remove the screw from the graphics board as shown in Figure 1-17.

Graphics board

A

Flex cables

Digital Video board

Screw

UP
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Figure 1-18 Sliding the Cable Guard Under the I/O Panels

2. Slide the two prongs under the I/O panels.

3. Push the cable protector toward the flex cables, laying the top hook on the top of the
graphics board. Continue placing pressure on the flex cables.

Graphics board

A

Cable guard

Digital Video board

1

2
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Figure 1-19 Sliding the Cable Guard Behind the Standoff

4. Press down on the center hole of the cable guard and slide the cable guard
(backward) until the bottom half-hook on the cable guard rests behind the standoff
between the Digital Video board and its daughterboard.

Graphics board

A

Cable guard

Digital Video board

Standoff 

Top of graphics board
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Figure 1-20 Attaching the Screw to Anchor the Cable Guard to the Graphics Board

5. Place the screw from the graphics board through the hook on the cable guard and
the graphics board, and into the standoff on the XIO module.

Note: If you receive a screw with the cable guard, use this longer screw instead of
the screw you just removed from the graphics board.

You have finished installing the flex cables and cable guard.

Graphics board

A

Cable guard

Digital Video board

Screw

UP
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Figure 1-21 Removing the Cap From the Compression Connector

6. Remove the cap from the XIO compression connector. Keep the cap to protect the
compression connector should you ever remove this board.

Go to page 25 for instructions on replacing the XIO module.

Caution: Do not touch
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Replacing the XIO Module

Figure 1-22 Installing Slots A and D Toward the Interior of the OCTANE Workstation

Caution: The XIO module must be replaced with the graphics board toward the interior
of the workstation to prevent overheating and damage to the boards. If the XIO module
with the OCTANE/SSI or OCTANE/MXI graphics board is inserted incorrectly, a
notifier appears during power on telling you to insert the XIO module with the graphics
boards toward the interior of the workstation, and power-on stops. Power off the system
and correctly insert the XIO module as shown in Figure 1-22.

XIO module

Slot D

Slot C

XIO module

Slot B
Digital Video board

Slot C

OCTANE SI/SI OCTANE SSI or MXI/SI

Slot B
Digital Video board  

Slot A 
Graphics board
     OCTANE/SI

Slot A
Graphics board
      OCTANE/SSI
      or /MXI

Slot D  
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Figure 1-23 Replacing the XIO Module

Follow these steps to install the XIO module:

1. Replace the XIO module in the OCTANE workstation. Slide the XIO module into
guides on the top and bottom of the workstation.

2. Before you insert the XIO module, make sure the handle portion protrudes in a
locked position from the I/O panels as shown in Figure 1-23.

If the handles are flush with the I/O panels, the XIO module will stop during
insertion. Pull out the handles until the sliding portion of the XIO module looks like
that shown in Figure 1-23, and then continue inserting the XIO module into the
chassis.

3. Use the handles to push the XIO module into a locked position.

Note: The I/O panels are not completely flush with each other or the chassis; there
is some slight variation in the depth of the individual boards.

XIO module

Digital Video board
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Figure 1-24 Replacing the XIO Module Screws

4. Tighten the screws in the handles so that the XIO module is attached to the chassis.

5. Remove the wrist strap.

Digital Video board
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Figure 1-25 Replacing the Monitor Cable

6. Reattach the monitor cable to the I/O connector.

You have finished replacing the XIO module and are ready for the next step. Go to
“Powering On the OCTANE Workstation” on page 29.

To monitor

Digital Video 
board
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Powering On the OCTANE Workstation

Figure 1-26 Powering On the OCTANE Workstation

1. Plug the power cord into an electrical outlet.

2. Push the power button on the front of the OCTANE workstation.

3. Push the power switch on your monitor.

Power button

Power cord

1
2

Power button3
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Setting Up Single-Link and Dual Link Connections

The OCTANE Digital Video board supplies 8- or 10-bit digital video ports that comply
with the CCIR-601 and SMPTE-259M standards. These serial ports are located on the
Digital Video board.

The ports can be configured for 4:4:4:4 or 4:2:2:4 dual-link mode, or for 4:2:2 single-link
mode. Each port consists of two one-direction connections, Link A and Link B.

Figure 1-27 and Figure 1-28 on the following pages show examples of single-link and
dual-link connections using digital-to-analog and analog-to-digital converters. After you
attach digital source equipment to the breakout cable, you choose the mode you want
using the video control panel. Instructions for using the video control panel follow
Figure 1-29 on page 33.

Table 1-2 Port Configuration

Mode/Channel 4:4:4:4 4:2:2:4 4:2:2

Link A Y; U and V from
even-numbered
sample points

Y, U, V

Link B alpha; U and V from
odd-numbered
sample points

alpha n/a

Single link n/a n/a Y U, V (no alpha)
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Figure 1-27 Connecting Analog-to-Digital and Digital-to-Analog
Converter-Single Link
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Figure 1-28 Connecting Analog-to-Digital and Digital-to-Analog
Converters-Dual Link

Composite in

Serial digital out 1

Sync out

Serial digital out 2

Y
R-Y

B-Y
Serial digital In

 1

Serial digital In
 2

Composite video

S video

Sync in
Analog-to-Digital
converter

Digital-to-Analog
converterTo components

(e.g. Beta Cam SP)

To monitor

To S-VHS or H
i-8

Camera

Digital Video board

Compression board

Graphics board

In 1

Reference

Loop

Out 1

Out 2 Alpha

In 2 Alpha

   

Trigger 



Setting Up for a Video Source

33

Setting Up for a Video Source

The Video Panel is accessed from the Toolchest, or a UNIX shell.

You can access the Video Panel from the Toolchest:

1. Choose Toolchest > Find > Control Panels > Video Panel. Double-click on the Video
Panel icon in the Control Panel Icon Catalog. Drag the icon to the desktop for
frequent usage.

2. To access the Video Panel from the Find menu, choose Toolchest > File QuickFind.
The Video Panel appears. Drag the icon to the desktop for frequent usage.

To access the Video Panel from a UNIX shell:

1. Open a shell by clicking the Console icon or choose “Unix Shell” from the Desktop
menu in the Toolchest.

2. Enter at the prompt:

/usr/sbin/vcp

The Video Panel appears (Figure 1-29).

.

Figure 1-29 Video Panel

3. Select the Default In and Default Out setting that matches your input and output
channels.
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The settings for the Default In and Default Out controls are Digital In 1, Digital In 2,
and Digital In Dual.

4. Select the Input Timing setting that matches your equipment. Choose CCIR-601 525
for NTSC, or CCIR-601 625 for PAL.

5. Select the Sync setting. Choose the Internal setting if you don’t have a genlock
reference; otherwise, choose the Genlock setting.

6. Select the Sync Source setting.

• Choose Genlock Input if you have a genlock reference. Make sure that you also
choose Genlock in the Sync option.

• If you don’t have a genlock reference but need genlock input, choose the Digital
In 1 or Digital In 2 setting.

7. Select the Autophase setting. Autophasing synchronizes the two input channels
with the rest of the system. There are four settings:

• The Normal setting synchronizes the input signals if the timing is within 1/2
line of the genlock reference signal. This is the most typical setting.

• The Extended setting synchronizes the input signals when they are within four
lines of the genlock reference signal.

• The Variable settings locks input signals when they are within four lines of each
other, but not locked to the genlock reference signal.

• The Off setting disables autophasing so that the input channels are not
synchronized.

8. Choose Close from the File menu when you have finished changing the settings.

Checking and Troubleshooting the Installation

Before checking the installation:

• Be sure you have installed the software on the OCTANE Digital Media CD. Refer to
the instructions that came with the CD.

• Turn on the system power and log in to your system.
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To check the OCTANE Digital Video board installation, follow these steps:

1. Open a shell by clicking the Console icon or choose “Unix Shell” from the Desktop
menu in the Toolchest.

2. Enter at the prompt:

hinv

Then press Enter.

You see a listing of your system’s hardware devices.

If you don’t see a similar line indicating that your system recognizes the board,
perform these checks after powering off the OCTANE workstation and following
the appropriate steps as outlined in this manual:

■ Make sure the graphics boards are inserted toward the interior of the
workstation.

■ Make sure the XIO module is seated, and the Digital Video and Compression
boards I/O panels are relatively flush with the chassis. If not, follow the
instructions in this chapter from powering off the workstation through
removing the XIO module, and see if an XIO compression connector cap is on
any XIO compression connector. If so, remove the cap, and follow the
instructions in this chapter for reinstalling the XIO module and powering on the
workstation.

Table 1-3 Hardware Inventory - Digital Video Board

If you have: You should see:

Digital Video board Digital Video: unit 1, revision 4.2,
TMI: revision 2, CSC: revision 1

Digital Video board attached with
flex cables to a Compression board

Digital Video: unit 1, revision 4.2,
TMI: revision 2, CSC: revision 1

IMPACT Compression: unit 0,
revision 0:1 with Flex cables.

Digital Video board, Compression
board, but not connected to each
other

Digital Video: unit 1, revision 4.2,
TMI: revision 2, CSC: revision 1

IMPACT Compression: unit 0,
revision 0:1
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■ Check the flex cable connections to the graphics board. They must be
completely seated. Follow the directions earlier in this chapter from powering
off the workstation to connecting the flex cables from the OCTANE Digital
Video board to the graphics board. Then follow the instructions to seat the flex
cables through powering on the workstation.

■ If you have an OCTANE Compression board installed, make sure that the flex
cables are securely attached between the OCTANE Digital Video and OCTANE
Compression boards.

3. Go to “Powering On the OCTANE Workstation” on page 29 and follow the
instructions though powering on the OCTANE workstation.

Product Support

Silicon Graphics, Inc. provides a comprehensive range of product support for its
products. If you are in North America and would like support for your Silicon Graphics
supported products, contact the Technical Assistance Center at 1-800-800-4SGI or your
authorized service provider. If you are outside North America, contact the Silicon
Graphics subsidiary or authorized distributor in your country.

Returning Parts

To return any part, use the packaging materials and box that come with your replacement
part.
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Placing a Regulatory Label

Figure 1-30 Rear View of the OCTANE Workstation

If you received a system upgrade label, place it on the system label.

1. Face the back of the OCTANE workstation. The system label (containing the model
and CMN number) is located at the top center of the back of the workstation.

2. Place the label over the VCCI and CISPR 22 information.
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2. Removing the Digital Video Board

This chapter provides detailed information on removing the Digital Video board. Here is
a quick summary of the steps:

To remove the Digital Video board you power off the workstation, wait 5 minutes,
remove any cables, remove the XIO module, attach a wrist strap, remove the Digital
Video board, replace it or insert a blank panel, replace the XIO module, replace the cables,
and power on the workstation. Follow the directions in this chapter to remove this board.

Figure 2-1 Orienting the XIO Module and Graphics Board

1. Go to Chapter 1, “Preparing the Workstation” on page 3, and follow the directions
through removing the XIO module. Be sure you have placed a cap on the graphics
board XIO compression connector. Then return to this section.

2. Position the XIO module so that slots D and A are facing you.

Graphics board

Blank panel

I/O panel

XIO module

Slot D

Cap

Cable guard

UP

Slot A
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Removing the Cable Guard and Flex Cables

Figure 2-2 Removing the Cable Guard

1. Remove the cable guard by removing the screw holding the cable guard to the
graphics board and XIO module.

Graphics board

A

Cable guard

Digital Video board

Screw

UP
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Figure 2-3 Sliding the Cable Guard Beneath the I/O Panels

2. Press down on the middle of the cable guard and slide it beneath the I/O panels.
This action releases the cable guard half-hook from behind the standoff. You feel
pressure from the flex cables.

Graphics board

A

Cable guard

Digital Video board

Standoff
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Figure 2-4 Sliding the Cable Guard From Beneath the I/O Panels

3. Slide the cable guard off the XIO module and boards.

■ Pull the cable guard away from the XIO module, so that the hook and half-hook
are free.

■ Slide the cable guard out from under the edges of the I/O panels.

4. Keep the cable guard. You use it whenever you are connecting an option board to
the graphics board with flex cables.

Graphics board

A

Cable guard

Digital Video board

1

2



Removing the Cable Guard and Flex Cables

43

Figure 2-5 Replacing the Screw Holding the Graphics Board to the XIO Module

5. Replace the screw through the graphics board into the standoff on the XIO module.

Graphics board

A

Flex cables

Digital Video board

Screw

UP
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Figure 2-6 Releasing the Flex Cables from the Graphics Board

6. Detach the flex cables from the graphics board beginning with the cable labeled C.

■ Press down on the release levers on the ends of the flex cables.

■ Press one release lever, then the other.

1

2

Cable connector

Board

Push levers down to
release connectors

C
B

A
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Figure 2-7 Removing the Flex Cables

7. Pull up on the connector until it releases.

8. Remove flex cable B, then flex cable A, following the instructions in steps 6 and 7.

9. Turn the XIO module over.

I/O panel

ABC

Graphics board

UP
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Detaching the Digital Video Board From the XIO Module

Figure 2-8 Disconnecting Digital Video-to-Compression Cables

Note: Do not try to remove the flex cables from the Digital Video board. These cables are
permanently attached.

1. If the Digital Video board is attached to a Compression board, remove the cables
that connect the two boards. If it is not attached to Compression, skip to step 2.

■ First pull up on the tabs on the Digital Video connectors until the connector
releases.

■ Remove the cables from the Compression board by pulling up on them. If
necessary, slide the flat blade of the reversible screwdriver under the edge of the
connectors to loosen them.

Slot B

Slot C

B

C
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Figure 2-9 Removing the Digital Video Board

2. Remove the four long screws holding the Digital Video board to the XIO module.

3. Lift the Digital Video board from the XIO module. Place it on a clean, dry, antistatic
surface. Your desktop works well.

Note: Do not detach the Digital Video daughterboard from the Digital Video board.

Graphics board

Slot C

Slot B

B

C

Digital Video screws
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Placing an Option Board or Blank Panel in Slot B

After you have removed the Digital Video board, choose your next step from Table 2-1.

A blank panel must be installed in slot B of the XIO module if no option board is installed
in that slot. If a blank panel is also in slot C, a baffle must be placed over them to allow
proper airflow in the workstation.

Table 2-1 Choosing the Next Instruction

Task Go To

Installing a new Digital Video board Chapter 1, “Attaching the OCTANE
Digital Video Board to the XIO Module”
on page 13

Installing a different option board The installation guide for that option
board

Installing a blank panel The next step
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Figure 2-10 Placing a Blank Panel in Slot B

1. Place the blank panel on the standoffs in slot B.

2. Use two short screws to attach the blank panel (on the outside edge) to the XIO
module if you are installing a baffle, as shown in Figure 2-10.

3. Use four short screws (in all four holes) to install the blank panel to the XIO module
if you are not installing a baffle.

Caution: Using the four, long, Digital Video board screws to attach a blank panel to
the XIO module damages the XIO module standoffs. The long screws are keyed to
insert only to a certain depth; the blank panels are much thinner than the Digital
Video board. Attempting to insert the screws completely damages the XIO module
standoffs.

Blank panels

C

B

Screws



50

Chapter 2: Removing the Digital Video Board

Figure 2-11 Placing the Baffle Over Two Blank Panels

4. If you have a blank panel in slot C, place a baffle over both blank panels.

■ First remove the two inside two screws from the blank panel in slot C.

■ Place the baffle across the two blank panels.

■ Insert and tighten the four screws that hold the baffle to the blank panels and
XIO module.

5. If you are sending the Digital Video board to your authorized service representative,
use the packing material and box in which you received your replacement part.

6. Go to “Replacing the XIO Module” on page 25.

Blank panel

Baffle

Slot B

Slot C

B

C
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Product Support

Silicon Graphics, Inc. provides a comprehensive range of product support for its
products. If you are in North America and would like support for your Silicon Graphics
supported products, contact the Technical Assistance Center at 1-800-800-4SGI or your
authorized service provider. If you are outside North America, contact the Silicon
Graphics subsidiary or authorized distributor in your country.

Returning Parts

To return any part, use the packaging materials and box that come with your replacement
part.
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3. Installing the OCTANE Compression Board

About the OCTANE Compression Board

The OCTANE Compression motion JPEG option board provides two independent
channels of full-resolution, full-motion, real-time video compression and decompression
for OCTANE workstations. It provides everything required for most video applications:
video I/O (composite or S—video) with genlock, capture, compression and
decompression, and playback. The OCTANE Compression board is compatible with all
OCTANE graphics solutions.

The OCTANE Compression board works alone, or linked to the OCTANE Digital Video
board for applications that require broadcast quality. The two boards are linked by a
dedicated data path, ensuring real-time passage of digital video data and allowing
compressed digital video streams to be used as elements in effects such as real-time
keying, blending, and video texture mapping. This digital video solution provides an
ideal environment for broadcast-quality non-linear editing, spot playback, and still
storage.

OCTANE System Compatibility

• Single-slot XIO

• Internal digital interface to OCTANE Digital Video
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Table 3-1 lists the key features and specifications of the OCTANE Compression board.

* Pin 6 of the S-video Input connector has a +12 V supply that can be used to power a camera. There is a
0.3 amp fuse on the line due to safety regulations.

Standards Supported:

• NTSC square pixel (525/60 Hz)

• NTSC CCIR-601 (525/60 Hz)

• PAL square pixel (625/50 Hz)

• PAL CCIR-601 (625/50 Hz)

Processing:

• 2 independent JPEG compression/decompression channels

• Zoran ZR36050 and ZR36016 per channel

• 2 uncompressed raw channels

• Real-time color space conversion between RGB and YUV

• Arbitrary down-scaling of all video formats

• Audio/video synchronization

Table 3-1 OCTANE Compression Key Features and Specifications

Video Inputs Video Outputs Genlock Connectors

Composite Composite Reference BNC

Y/C (S-Video)* Y/C (S-Video) S-Video (mini-circular
DIN)

Loop BNC
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Unpacking the OCTANE Compression Board

Figure 3-1 Compression Board Shipment

Check your shipment when you receive it. You should receive the supplies shown in
Figure 3-1.

Installing System and Compression Software

Before shutting down your system and installing the OCTANE Compression board,
install the appropriate version of the IRIX operating system and any OCTANE
Compression software from the OCTANE Digital Media CD.

Also see the CD booklet enclosed with the CD for information on remotely logging in to
another machine with a CD-ROM drive.

Wrist strap

Reversible screwdriver

Documentation

Digital Video - Compression
flex cables

OCTANE Compression board

XIO compression connector cap

Digital Media CD
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To review release notes, choose Toolchest > Help > Release Notes. Release notes are
available here after the software has been installed.

To display ASCII test in an IRIX shell, at the prompt, enter cdrelnotes.

Preparing the Workstation to Install the Compression Board

Go to “Preparing the Workstation” on page 3 and follow the instructions through
“Removing the XIO Module.” Then return to this section and follow the instructions.

Tools and Parts Needed

• A wrist strap

• A reversible screwdriver

• Documentation

• An XIO compression connector cap to protect the XIO compression connector when
it is out of the workstation. (A cap comes on the Digital Video and the Compression
boards’ XIO compression connector. Extra caps come with the workstation.)

• A blank panel if you are removing the Compression board and not replacing it. (A
blank panel came with the workstation and was in the slot filled by the OCTANE
Compression board.)

• Two small cables for attaching the OCTANE Compression board to the OCTANE
Digital Video board.

About the XIO Module

The XIO module is the holding mechanism for XIO graphics or XIO option boards and
holds up to four boards. It can be thought of as a tray to which boards are attached. The
four quadrants of the XIO module are Slots A, B, C, and D. Slots D and A are on one side,
Slots B and C on the other. A graphics board, option board, or blank panel attaches to
each slot on the XIO module. The only exception is the OCTANE/SSI or OCTANE/MXI
graphics boards which occupy two slots, A and D.

• The XIO module must be replaced with the graphics board in Slot A toward the top
of the workstation, or the boards may overheat and be damaged.
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• The graphics board is always in slot A or slots A and D.

• Option boards occupy slots B and C and possibly D.

• Graphics and option boards may be linked by flex cables.

• Protective blank panels must be placed in unused slots.

• The XIO compression connector is always covered by a protective cap when the XIO
board is out of the OCTANE workstation.

• Extra caps for the compression connectors come with the workstation.

If you lose a screw that holds the graphics board, single-layer option boards, or blank
panels to the XIO module, use M3 x 8 mm size screws.

Removing a Blank Panel or Option Board

This section explains how to remove a blank panel or option board from the XIO module.
See Table 3-2 to determine the proper compression board placement.

Table 3-2 Compression Board Installation Slots

Compression Board Slot Placement

Attached to the Digital Video board Slot C

As a standalone board (not attached by flex
cables to any other board)

Slot C only
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Figure 3-2 Removing the Baffle

1. Turn the XIO module so that slots B and C are facing you.

If you have an option board in slots B or C, go to step 4. If you have a baffle attached
to two blank panels, as shown in Figure 3-2, go to step 2.

2. Remove the baffle attached to the two blank panels.

■ Using a Phillips screwdriver, remove the four screws holding the baffle to the
two blank panels.

■ Remove the baffle.

■ Replace the two screws into the blank panel in slot B.

3. Remove the remaining screws from the blank panel in slot C. Go to step 6.

Slot B

Slot C

B

C

Baffle

Blank panel
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Figure 3-3 Removing a Blank Panel or XIO Standalone Option Board

4. Remove any XIO option board or blank panel from the slot C. See the option board
installation manual for instructions on removing the option board.

5. Using a Phillips screwdriver, remove the four screws holding the board or blank
panel to the XIO module.

6. Lift the blank panel from the XIO module.

For illustration purposes, the blank panel is shown here.

Blank panels

Screws

B

C
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Figure 3-4 Attaching the Compression Board to the XIO Module

Caution: The XIO compression connectors on the back of all XIO boards are
extremely delicate and easily damaged. Keep the cap on the XIO compression
connector until you are ready to replace the XIO module in the chassis. See your
OCTANE Workstation Owner’s Guide for more information about the XIO
compression connector.

7. Place the Compression board on the standoffs in slot C.

8. Insert the four screws through the board into the standoffs.

9. Tighten the screws.

Slot C

Slot B

B

C

Screws
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Figure 3-5 Removing the XIO Compression Connector Cap

10. If you are not connecting the Compression board to the Digital Video board, remove
the cap from the XIO compression connector now. Keep it should you ever need to
remove this board. If you are attaching the Compression board to the Digital Video
board, leave the cap on the XIO compression connector.

Table 3-3 Choosing the Next Instruction

Compression Installed Go to

As a standalone board (not attached by
flex cables to another board).

“Replacing the XIO Module” on page 64 and follow
the instructions through powering on the OCTANE
workstation. Then go to “Connecting the Cables” on
page 68.

Attached to the Digital Video board. Page 58.

Caution: Do not touch
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Attaching a Compression Board to the Digital Video Board

Figure 3-6 Connecting the Cables Between the Compression Board and the Digital Video
Board

To attach the Compression board to the Digital Video board in slot B, follow these steps:

1. Attach the two half-size flex cables to the connectors on the Digital Video board.
The connector with the pull tab attaches to the Digital Video board.

2. Attach the connector on the other end of the cable to the connector on the
Compression board. Press firmly on the center of each connector to completely seat
it.

3. Repeat the process with the other cable.

B

C
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Figure 3-7 Removing the XIO Compression Connector Cap

4. Remove any XIO compression connector caps you placed on XIO graphics or option
boards. Keep them should you ever need to remove this or any other board or
module.

Caution: Do not touch
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Replacing the XIO Module

Figure 3-8 Installing the XIO Module With Slots A and D Toward the Interior of the OCTANE
Workstation

Caution: The XIO module must be replaced with the graphics board toward the interior
of the workstation to prevent overheating and damage to the boards. If the XIO module
with the OCTANE/SSI or OCTANE/MXI graphics board is inserted incorrectly, a
notifier appears during power on telling you to insert the XIO module with the graphics
boards toward the interior of the workstation, and power-on stops. Power off the system
and correctly insert the XIO module as shown in Figure 3-8.

XIO module

Slot D

XIO module

Slot B
    Digital Video board

Slot C
    Compression board

OCTANE SI/SI OCTANE SSI or MXI/SI

Slot B
    Digital Video board  

Slot A 
Graphics board
     OCTANE/SI

Slot A 
    Graphics board
    OCTANE/SSI
    or /MXI

Slot D  

Slot C
    Compression board
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Figure 3-9 Determining the Orientation of the XIO Module

To replace the XIO module, follow these instructions:

1. Slide the XIO module into guides on the top and bottom of the workstation, to
replace the XIO module.

2. Before you insert the XIO module, make sure the handle portion protrudes from the
I/O panels in a locked position. If the handles are flush with the I/O panels, the
XIO module stops during insertion. Pull out the handles, and then continue
inserting the XIO module into the chassis.

XIO module

Digital Video 
board

Compression 
board
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Figure 3-10 Placing the XIO Module in the OCTANE Chassis

3. Grasp the handle area while supporting the XIO module, and slide the module into
the chassis.

4. Use the handles to push the XIO module into a locked position. (The I/O panels are
nearly flush with the workstation when properly inserted; however, there is a slight
variation in the depth of the boards.)

Caution: Slide the XIO module into the chassis carefully. The components on the
boards can be damaged if the boards rub on the sides of the chassis.

XIO module

Digital Video 
board

Compression 
board
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Figure 3-11 Attaching the XIO Module to the Chassis

5. Tighten the captive screws in the XIO module handles to attach the XIO module to
the chassis.

6. Remove the wrist strap.

Digital Video board

Compression board
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Connecting the Cables

Figure 3-12 Connecting the Cables and Powering On

To connect the cables, follow these steps:

1. Reattach the graphics monitor cable to the graphics board.

To monitor

Digital Video 
board

Compression 
board
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Figure 3-13 OCTANE Compression Board Connectors

2. Attach the necessary cables to the OCTANE Compression board.

   

Composite In

S Video In

Reference

Loop

S Video Out
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CI

YCI

Ref

Loop

YCO

CO
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Powering On the OCTANE Workstation

Figure 3-14 Powering On the OCTANE Workstation

1. Plug the power cord into an electrical outlet.

2. Push the power button on the front of the OCTANE workstation.

3. Push the power switch on your monitor.

Setting Up for a Video Source

The Video Panel is accessed from the Toolchest, or a UNIX shell.

You can access the Video Panel from the Toolchest:

1. To access the Video Panel, choose Toolchest > Find > Control Panels > Video Panel.
Double-click on the Video Panel icon in the Control Panel Icon Catalog. Drag the
icon to the desktop for frequent usage.

Power button

Power cord

1
2

Power button3
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2. To access the Video Panel from the Find menu, choose Toolchest > File QuickFind.
The Video Panel appears. Drag the icon to the desktop for frequent usage.

To access the Video Panel from a UNIX shell:

1. Open a shell by clicking the Console icon or choose “Unix Shell” from the Desktop
menu in the Toolchest.

2. Enter at the prompt:

/usr/sbin/vcp

.

Figure 3-15 Video Panel

The Video Panel appears (Figure 3-15). It looks slightly different from this example.

3. Select the Default In and Default Out setting that matches your input and output
channels.

• The settings for the Default In controls are Digital In 1, Digital In 2, and Digital
In Dual.

• The settings for the Default Out controls are Digital In 1, Digital In 2, and Digital
In Dual.

4. Select the Input Timing setting that matches your equipment. Choose CCIR-601 525
for NTSC, or CCIR-601 625 for PAL.

5. Select the Sync setting. Choose the Internal setting if you don’t have a genlock
reference; otherwise, choose the Genlock setting.



72

Chapter 3: Installing the OCTANE Compression Board

6. Select the Sync Source setting.

• Choose Genlock Input if you have a genlock reference. Make sure that you also
choose Genlock in the Sync option.

• If you don’t have a genlock reference but need genlock input, choose the Digital
In 1 or Digital In 2 setting.

7. Select the Autophase setting. Autophasing synchronizes the two input channels
with the rest of the system. There are four settings:

• The Normal setting synchronizes the input signals if the timing is within 1/2
line of the genlock reference signal. This is the most typical setting.

• The Extended setting synchronizes the input signals when they are within four
lines of the genlock reference signal.

• The Variable settings locks input signals when they are within four lines of each
other, but not locked to the genlock reference signal.

• The Off setting disables autophasing so that the input channels are not
synchronized.

8. Choose Close from the File menu when you have finished changing the settings.

Checking and Troubleshooting the Installation

Before checking the installation:

• Be sure you have installed the software from the OCTANE Digital Media CD. Refer
to the instructions that came with the CD.

• Turn on the power and log in to your OCTANE workstation.

To check the OCTANE Compression board installation, follow these steps:

1. Open a shell by clicking the Console icon or choose “Unix Shell” from the Desktop
menu in the Toolchest.

2. At the prompt, type:

hinv

Then press Enter.
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You see a listing of your system’s hardware devices.

If you don’t see a similar line indicating that your system recognizes the board,
perform these checks after powering off the OCTANE workstation and following
the appropriate steps as outlined in this manual:

■ Make sure the XIO module is seated, and the Compression board’s I/O panel is
flush with the chassis. If not, release the captive screws in the XIO module
handle, remove the XIO module, and check if any XIO compression connector
caps are on XIO graphics, option or Compressions boards. Remove the caps,
and reinstall the XIO module.

■ If you have an OCTANE Digital Video board installed, make sure that the flex
cables are securely attached between the OCTANE Digital Video and
Compression boards.

Table 3-4 Hardware Inventory - Compression Board

If you have You see

Compression board only, no
Digital Video board

IMPACT Compression: unit 0,
revision 0:1

Compression board attached with
flex cables to a Digital Video board

IMPACT Compression: unit 0,
revision 0:1 with Flex cables.

Compression board, Digital Video
board, but not connected to each
other

Digital Video: unit 1, revision 4.2,
TMI: revision 2, CSC: revision 1

IMPACT Compression: unit 0,
revision 0:1
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Placing a Regulatory Label

Figure 3-16 Rear View of the OCTANE Workstation

If you received a system upgrade label, place it on the system label.

1. Face the back of the OCTANE workstation. The system label (containing the model
and CMN number) is located at the top center of the back of the workstation.

2. Place the label over the VCCI and CISPR 22 information.

XIO module

Fan
Model/CMN number

Lockbar 

Microphone

Speakers/headphone

Speaker power

Analog line level audio

Coaxial digital audio in/out

Optical digital audio - in

Optical digital audio - out

SCSI

Ethernet

Parallel

Mouse

Serial ports

Keyboard  

In Out

1

R L

XIO boards
(graphics and
communications)

PCI module

Stereo view

Monitor

Serial number

Power supply

Power cord

System module

2

System label
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Product Support

Silicon Graphics, Inc. provides a comprehensive range of product support for its
products. If you are in North America and would like support for your Silicon Graphics
supported products, contact the Technical Assistance Center at 1-800-800-4SGI or your
authorized service provider. If you are outside North America, contact the Silicon
Graphics subsidiary or authorized distributor in your country.

Returning Parts

To return any part, use the packaging materials and box that came with your replacement
part.
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4. Removing the OCTANE Compression Board

To remove the Compression board, go to “Preparing the Workstation” on page 3 and
follow the instructions through “Removing the XIO Module” on page 7. Then return to
this section.

Figure 4-1 Placing Caps on the XIO Compression Connectors

1. Turn the XIO module so that the Compression board in slot C is facing you.

2. Place caps on all of the XIO compression connectors.

Caution: Do not touch
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Detaching the Compression Board

Figure 4-2 Removing Compression-to-Digital Video Flex Cables

1. If the Compression board is attached by flex cables to the Digital Video board in
slot B, remove the connecting cables. If it is not connected to the Digital Video
board, go to step 2.

■ Grasp the pull tab on each connector on the Digital Video board and pull up
until the cable disconnects from the Digital Video board.

■ You may need to slide a flat-blade screwdriver under the edges of the
connectors on the Compression board to remove them.

Slot B

Slot C

B

C
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Figure 4-3 Removing the Compression Board

2. Remove the four screws holding the Compression board to the XIO module.

3. Remove the Compression board.

4. Replace the Compression board, or install a blank panel on the XIO module.

Go to Chapter 3 for instructions on installing a Compression board, or go to the next
section for instructions on installing a blank panel. If you are installing another option
board, use the installation instructions in the option board manual.

Slot C

Slot B

B

C

Screws
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Attaching an Option Board or Blank Panel to the XIO Module

For instructions on installing a Compression board, see “Attaching a Compression Board
to the Digital Video Board” on page 62.

Figure 4-4 Installing a Blank Panel

1. To install a blank panel:

■ Place the blank panel on the XIO module.

■ Insert and tighten two screws through the blank panel into the standoffs on the
XIO module. (Use four screws if you are not installing a baffle.) (For illustration
purposes, a blank panel is shown being installed in slot B.)

Blank panels

C

B

Screws
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Figure 4-5 Installing the Baffle

2. If you have two blank panels side by side, install the baffle. Go to step 3 for
instruction. If not, Go to “Replacing the XIO Module” on page 64 for instructions on
replacing this module and powering on the OCTANE workstation.

3. To replace the baffle, remove the inner two screws from the blank panel in slot C.

■ Place the baffle across the two blank panels.

■ Insert and tighten the four screws that hold the baffle to the blank panels and
XIO module.

■ Insert the remaining two screws into the outer edge of the blank panel in slot B.

Go to “Replacing the XIO Module” on page 64 for instructions on replacing this module
and powering on the OCTANE workstation.

Baffle

Blank panel

Slot B

Slot C

B

C
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Product Support

Silicon Graphics, Inc. provides a comprehensive range of product support for its
products. If you are in North America and would like support for your Silicon Graphics
supported products, contact the Technical Assistance Center at 1-800-800-4SGI or your
authorized service provider. If you are outside North America, contact the Silicon
Graphics subsidiary or authorized distributor in your country.

Returning Parts

To return any part, use the packaging materials and box that came with your replacement
part.
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A. Framelocking

In order to smoothly record graphics from a graphics monitor, the video and graphics
signals must be synchronized by framelocking the video and graphics. Framelocking
eliminates tearing and motion artifacts that occur if the video and graphics signals are
not synchronized.

To lock graphics to video, enter the command in the UNIX shell for the video standard
you are using:

• For the PAL standard, type the command

setmon -Fe 1280x1024_49

• For the NTSC standard type the command

setmon -Fe 1280x1024_59

If you are running double-buffered 32-bit RGBA format on OCTANE/SI or
OCTANE/SSI, the timing table values are:

/usr/gfx/setmon -x 1280x1024_72_32db for 72Hz
/usr/gfx/setmon -x 1280x1024_60_32db for 60Hz
/usr/gfx/setmon -x 1280x1024_50_32db for 50Hz

After saving the format, to re-initialize the graphics system with the new mode, type:

/usr/gfx/gfxinit

To enable framelocked, double-buffered 32-bit RGBA format on OCTANE/SSI, type:

/usr/gfx/setmon -x <timing table>
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For example,
/usr/gfx/setmon -x 1280x1024_59_32db for 60Hz
/usr/gfx/setmon -x 1280x1024_49_32db for 50Hz

1. To reinitialize the graphics system with the double-buffered mode, type:

/usr/gfx/gfxinit

2. Type the following command for framelocking:

/usr/gfx/setmon -Fe 1280x1024_59_32db

or

/usr/gfx/setmon -Fe 1280x1024_49_32db

For framelocking for OCTANE/SI, see the information below.

To select the head with the video connection, which is determined by the pipe number,
see the reference (man) pages of setmon for detailed information.

To select the head that has video connected, type:

/usr/gfx/setmon -p <pipe number> -Fe <timing table>

or

/usr/gfx/setmon -p <pipe number> -Fe <timing table>

For Example,
/usr/gfx/setmon -p 0 -Fe 1280x1024_59_32db for 60Hz
/usr/gfx/setmon -p 0 -Fe 1280x1024_49_32db for 50Hz
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B. Identifying OCTANE Digital Video, Compression, and
Graphics Boards

This appendix provides illustrations of the

• “OCTANE Digital Video Board With Daughterboard” on page 86

• “OCTANE Compression Board” on page 87

• “OCTANE/SI Graphics Board” on page 88

• “OCTANE/SI With Texture Memory Option Board” on page 88

• “OCTANE/SSI Graphics Board” on page 89

• “OCTANE/MXI Graphics Board” on page 90
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OCTANE Digital Video Board With Daughterboard

Figure B-1 OCTANE Digital Video Board With Daughterboard

XIO Compression Connector Cap



OCTANE Compression Board
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OCTANE Compression Board

Figure B-2 OCTANE Compression Board

XIO Compression Connector Cap



88

Appendix B: Identifying OCTANE Digital Video, Compression, and Graphics Boards

OCTANE/SI Graphics Board

Figure B-3 OCTANE/SI Graphics Board

OCTANE/SI With Texture Memory Option Board

Figure B-4 OCTANE/SI With Texture Memory Option Board

Connectors for texture
memory board

Cap on XIO compression
connector

Flex cable connectors

Connectors
beneath texture
memory board

Cap on XIO compression
connector

Flex cable connectorsTexture memory board
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OCTANE/SSI Graphics Board

Figure B-5 OCTANE/SSI Graphics Board

Flex cable connectors

Cap on
XIO compression
connector

Connectors for texture
memory boards 
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OCTANE/MXI Graphics Board

Figure B-6 OCTANE/MXI Graphics Board

Flex cable connectors

Connectors for texture
memory boards 

Cap on
XIO compression
connector

Texture memory boards
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C. Care and Cleaning of the XIO Compression Connector

The OCTANE workstation uses compression connectors to connect several modules and
boards to the frontplane of the workstation.

A single compression connector is used in the OCTANE workstation in these locations:

• on the back of the PCI module

• on each XIO board on the XIO module

Two compression connectors are used on the system module.

The compression connector has 96 pads that enable passage of signals between the
system (via the frontplane) and the system module, PCI module, or XIO board.

The compression connector has two halves: One half is located on the frontplane of the
chassis; the other, on the system module, PCI module, or XIO board. Each pad on a
frontplane connector is a flat gold-plated surface. Each pad on the system module, PCI
module, or XIO board is composed of hundreds of tiny bristles (dendrites). When a
bristled pad is pressed into a gold-plated pad, a connection is created for one signal.

Figure C-1 Identifying the Bristled Pad of the Compression Connector

The bristled pads may attract and hold dust, lint, grease, powder, and dirt. The presence
of these substances clogs or damages the bristles and prevents them from making proper
contact with the gold-plated pads on the system’s frontplane. It is import to prevent this
from occurring.

Bristled pad
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Guidelines for Storing and Handling the Compression Connector

To avoid damaging a compression connector and to keep it in optimal working
condition, follow these guidelines whenever the board is not installed.

• Do not wipe or touch the pads of the compression connector with anything (no
human fingers, no brushes, no cloth, no probes), except as specified in the cleaning
instructions. The bristles might be damaged.

• Whenever the module or board is not in the chassis, put the protective cap over the
compression connector and put the module or board in an antistatic bag. Make sure
to close (fold over) the open end of the bag to minimize exposure to dust and
atmospheric gases.

• Do not put anything (not even water) onto the pads, except as specified in the
cleaning instructions.

• Before laying the board on a surface, make sure that the surface is free of dust, lint,
powder, metal filings, oil, water, and so on.

• Do not blow dust, dirt, or powder anywhere near the board when it is not inside its
protective bag.

Caution: Failure to follow these instructions can result in irreparable damage to the
surface of the connector’s pads, which may result in intermittent or complete failure of
the product.

Guidelines for Cleaning the Compression Connector

A compression connector should never need to be cleaned if you keep the protective
cover on whenever the module or board is not in the chassis. However, if the connector
becomes dirty, follow the instructions below for removing pollutants.

Note: Some pollutants can irreversibly damage (corrode or chemically alter) the pad
surfaces. Although cleaning may remove the pollutant, it does not repair damage
incurred by this contact.
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To remove pollutants, follow these instructions:

1. Obtain a can of dry compressed air or inert gas. The Envi-ro-tech™ Duster 1671
product manufactured by TECHSPRAY™ (telephone 806-372-8523 in the USA)
works extremely well for this application.

Caution: Do not use a cleaning product that contains any of the following
ingredients: halogenated hydrocarbons, aromatic hydrocarbons, ethers, sulfur,
ketones, or solvents of any kind. These substances cause irreparable damage to the
connector’s surface.

2. Prepare the can for use, as instructed on the can. For example, if a tube is provided,
attach it to the can’s dispensing mechanism.

Figure C-2 Cleaning the XIO Compression Connector

3. Hold the can in a vertical position.
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4. Place or hold the XIO board so that the rounded edge of the compression connector
faces up. Note that the rounded edge is completely closed, so that air cannot flow
into the connector, whereas the squared edge has an opening.

Caution: Spraying into the squared (open) edge of the connector can destroy it.

5. Position the XIO board at an angle to the can, so that the tip of the can’s applicator is
1 to 2 inches away from the first (topmost) row of pads. Do not allow the applicator
to touch the pads. When you spray, the air hits each pad and flows downward.

6. Start spraying. As you spray, move the spray along the length of the connector until
the entire length has been sprayed. Move down a few rows and again spray along
the entire length.

Note: Do not shake the can. Stop spraying if any visible material (for example, foam)
appears. This form will blow away once you resume spraying just air.

7. Repeat until all the pads have been sprayed.

8. When you finish, cover the compression connector with its cap or immediately
install the board in an XIO slot.
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artifact

In video systems, an unnatural or artificial effect when the system reproduces an image.

bezel

The frame that holds the front cover and attaches to the front of the chassis.

B-Y signal

One of the color difference signals used on the NTSC and PAL systems derived by
subtracting luminance (Y) from the blue camera signal (B). The color mixture is close to
blue.

chassis

The metal framework of the workstation that contains its working parts.

choose

The action of pressing the left mouse button to bring up a popup menu, moving the
cursor to highlight the command that you want to run, and releasing the button.

composite video

A color encoding method or a video signal that contains all of the color, brightness, and
synchronizing information in one signal. The chief composite television standard signals
are NTSC, PAL, and SECAM. The OCTANE Digital Video board uses the NTSC and PAL
standards.

connector

The hardware at the end of a cable that fastens the cable to an outlet, port, or other
connector.

console

The window that appears as a stowed icon each time you log in; IRIX reports all status
and error messages to this window.
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cover

The molded plastic piece that fits over the chassis. The bezel and front cover attach to the
cover.

chrominance signal

The high-frequency portion of the video signal that is the color carrier.

front cover

The pulldown door that allows you to access the power button and drives.

genlock

Synchronizing with another video signal serving as a master timing source. The master
timing source can be a composite video signal, a video signal with no active video (only
sync information), or, for video studio, a device called a house sync.

luminance

The video signal that describes the amount of light in each pixel.

NTSC

National Television Systems Committee. A color television standard used in North
America and parts of South America and Asia for timing format encoding all color,
brightness, and synchronizing information in one signal. The NTSC format uses 525
horizontal lines per frame, with two fields per frame of 262.5 lines each. Each field
refreshes at 60 Hz.

PAL

Phase Alternated by Line. A color-television timing standard used by most countries in
Europe, Australia, and parts of Asia. The PAL standard uses a total of 625 lines per frame,
with two fields per frame of 312.5 lines per frame. Each field refreshes at 50 Hz.

pull straps

The straps you pull to remove the graphics board set from the chassis.

R-Y signal

A color difference signal obtained by subtracting the luminance signal from the red
camera signal. The color mixture is close to red.
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standoffs

Spacers that are used to stack and attach the graphics and video boards to each other.

texture mapping

The process of applying an image to a 3D object to add realism in the rendering.

Video Panel

A software control panel used for selecting video input; adjusting video signal levels and
timing characteristics; and selecting filtering, processing, and other options.

wrist strap

A flat cable that you wrap around your wrist and attach to a metal part of the workstation
whenever you work with internal components of the workstation. This prevents
electrical shocks to yourself and the components.

Y signal

The brightness of a video channel.

YUV

A color space (color component encoding format) used by the PAL video standard, in
which Y is the luminance signal, and U and V are the chrominance signals. The YUV
format derives colors from the RGB format.
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and to improve the quality of our documentation.

Any information that you provide will be useful. Here is a list of suggested topics:

• General impression of the document

• Omission of material that you expected to find

• Technical errors

• Relevance of the material to the job you had to do

• Quality of the printing and binding

Please send the title and part number of the document with your comments. The part
number for this document is 007-3466-001.

Thank you!

Three Ways to Reach Us

• To send your comments by electronic mail, use either of these addresses:

– On the Internet: techpubs@sgi.com

– For UUCP mail (through any backbone site): [your_site]!sgi!techpubs

• To fax your comments (or annotated copies of manual pages), use this
fax number: 415-965-0964

• To send your comments by traditional mail, use this address:

Technical Publications
Silicon Graphics, Inc.
2011 North Shoreline Boulevard, M/S 535
Mountain View, California  94043-1389


